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RESPONDING TO SURVEYS
Your organisation may require you to participate in a number of different types of surveys. The
FMCS provides the following types of surveys;
•

Compliance Surveys (containing questions regarding Non-Compliance)

•

Assurance Surveys

•

General Surveys.

•

On-Line Training

This section will assist you in how to access, respond and submit all of these types of surveys.
Note - FMCS has a facility to deliver on-line training using survey functionality. Online training
comprises a tutorial video (or other relevant media) followed by a series of questions relating to
the tutorial that the participant must provide a response to. The steps required to create an
online training tutorial are similar to those required to create a general survey, therefore
instructions on how to create an online training module will be included in the Creating and
Administering a Survey section.

Who Creates and Administers the Survey?
Surveys are created and administered by Survey Administrators. Users are given permission to
be Survey Administrators by the Survey Module Administrator. Note: Survey Module
Administrators are able to administer any survey.
Survey Administrators are responsible for:
•

Designing the Survey

•

Giving users required level of permissions to manage their staff’s survey responses,

•

Setting the workflow rules and what emails are sent to which users,

•

Collating the finalised Survey,

•

Recording and Reporting results of the Survey.

Accessing the Survey
The Survey Administrators may send emails to notify survey participants that there is a Survey
to be completed. This email may contain information about the survey including the closing
date and a hyperlink to the Survey. The Survey Administrator may also send out reminder
emails from time-to-time to users who are yet to complete the survey.
There are three ways to access the Survey:
1.

If you have been invited to a survey you will usually receive a notification email
containing a hyperlink to the survey. Click on the hyperlink in the email and you will be
taken directly to the survey, or
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2.

Select the Survey through your FMCS Home Page by clicking on the relevant Survey Tile
and then selecting the appropriate Survey from your In-Tray, or

3.

Selecting the Survey option from the In-Trays menu from top of screen and then
selecting the appropriate Survey from your In-Tray.

Note: The status of all Surveys are displayed on the right of the screen:
These are surveys that have been started, but not submitted.
These are surveys that have not been started.

Responding to a Survey
Once you are in the survey, you will be presented with the informative text (preamble) that was
configured to describe and provide necessary information about the survey. Below this you will
be presented with a series of questions to complete.
You may find Help icons
and help on that question.

in some questions. Click on these icons for further explanation

Some questions may give you the option Clear selected answer button. This allows you to deselect all responses to the question.
At any time you can Save the Survey as draft. This allows you to save your work, close it, and
return to continue the survey at a later time. Select the Save Draft button.
Note: Once the Survey Administrator closes the Survey you will no longer be able to continue
to work on it. It will no longer appear in your In-Tray.
You can print your survey at any time by selecting the Print icon located on the FMCS toolbar.

Responding to Non-Compliance Questions in a Survey
Your survey may contain Non-Compliance questions. Non-Compliance questions help capture
Non-Compliances not previously reported over the course of a given period. The questions
prompt users to consider if their actions have been in accordance with the agency’s legislative
and policy framework.
What happens if you know of a Non-Compliance related to a question?
If you know of a Non-Compliance related to a question, answer it accordingly. If any NonCompliances have already been recorded relating to this question it will be displayed in a grid
below the question. All previously recorded Non-Compliances that match the following rules
will be displayed if any of the following relate to you only for the set period and requirement;
•

you are involved in the Non-Compliance in any of the following capacities:
o

Committer of the Non-Compliance
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o

Supervisor nominated in the Non-Compliance report

o

Have edited or updated the Non-Compliance report

•

You are the current supervisor of the organisation unit nominated in the NonCompliance

•

You are the current supervisor of an organisation unit at a higher level to the
organisation unit nominated in the Non-Compliance

•

Permission has been given to survey participants to view Non-Compliances where the
organisation unit in the Non-Compliance is the same as your current organisation unit

•

Permission has been given to survey participants to view Non-Compliances where the
organisation unit in the Non-Compliance is below your current organisation unit

•

you have been given specific reporting permission to the organisation unit in the NonCompliance, or;

•

the Non-Compliance is viewable by anyone who you are the Survey Manager for.

If the Non-Compliance you know about does not appear in the listed Non-Compliances click
on Click to Add Non-Compliance button. You will be taken to the Non-Compliance Reporting
screen where you can enter all the relevant information. See How to Report a Non-Compliance
section for instructions. However, note when submitting a Non-Compliance during a survey you
will not be able to save draft or allocate the Non-Compliance to others.

How to Submit the Survey
Once you have completed the questions you are ready to Submit the Survey.
1.

Click on the Submit button.

2.

If any mandatory questions are not completed an error will be displayed.

3.

Questions requiring completion will have a red banner displayed under them.

4.

Complete all marked questions and Submit the Survey again.

5.

If a Declaration box appears, read the declaration. By selecting the I Agree button, you
are agreeing to the declaration and your survey will be submitted.

6.

A Confirmation message will appear to inform you the operation is complete.

7.

Your survey will now be locked and the Survey will now appear in the “Completed”
section of your In-Tray.

Delegating a Survey
Delegating a survey allows you to ask someone else to complete your survey on your behalf.
You will only be able to Delegate if you have been given permission by the Survey
Administrator. Your Survey screen will have a Delegate button at the bottom of the screen.
__________________________________________________________________
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1.

Select the Delegate button to send the survey to another person.

2.

Click on the Search icon.

3.

Enter part, all of the users name and select the Search button.

4.

Click on the Delegate’s name.

5.

Select the Delegate button.

6.

A confirmation box will appear.

7.

The survey is now open to the Delegate to respond.

8.

Once delegated, only the delegated person may update the survey. The delegated
person can also Manage Participants on behalf of the originator as well.

9.

While the survey originator cannot update the survey while it is delegated, they can,
however, continue to Manage Participants responding to them.

10.

When the delegate competes and submits the survey, it will be returned to the
originator for final review and submission.
Note: A Delegate cannot submit the survey on behalf of the originator. Only a Proxy
can submit survey on behalf of the originator. See Proxy for more details.

Cancelling a Survey Delegation
If you have delegated a survey and wish to cancel the delegation, you can select Cancel
Delegation button at any time. This will cancel the delegation and reopen the survey for you to
edit.

Responding to a Delegated Survey
If a survey has been delegated to you, you will see the messages circled below when you open
the delegated survey.

As the Delegate you can now perform the same functions as the person who delegated the
survey to you.
1.

If you select the Save Draft button you remain the Delegate and can return to the
survey again.

2.

You will only be able to Submit the survey if it is completed. Attempting to Submit an
incomplete survey will result in an error message.

3.

Select the Submit button, a confirmation box will appear. Select the appropriate
response. If you choose to Submit the survey it will return to the originator.

4.

Confirmation will appear.

5.

The Survey will return to the originator’s In-Tray for their review and Submission.
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Survey Managers
A survey manager is a person in the organisational structure who is participating in the survey
that also has lower level participants in the organisational structure participating in the same
survey. Survey Managers have been given additional permissions in the system to facilitate the
management of participants reporting to them in a survey. They may have all, or only some, of
the additional functions described below.
Survey Managers can;
View, monitor and grant permissions to other participant’s surveys.
Note: Survey Managers will only be able to see those functions that they have been
given permission to use.

How to view, monitor and grant permissions to the Participants you Manage
a)

Navigate to the survey via your ‘In-Tray’ and click on the Survey type option (eg
‘Compliance Surveys). Note: This option is only available if you are a participant of the
survey. Surveys that you have access to manage will be displayed.
Click on the Administer button of the relevant Survey,
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b)

Select the Participants open below to display the list of participants selected for this
survey.

Shown below is the Participants screen.

Note: To go back to your survey click on the back arrow at the top left of screen at any time.
Compress (Expand) View
Toggle the Compress View (Expand View) button to show less or more details for participants.
View Exceptions
An exception is an answer that differs from the standard responses in a survey. Survey
administrators can configure questions to trigger exceptions when a particular response is
selected against a survey question. The ‘Exceptions’ tab shows all exceptions logged within a
response. A survey manager can view all exceptions.
Click on the Exceptions tab to see all those participants who answered any question with an
answer that indicates an exception.
Note: The Survey Administrator sets up the exception indicators.

Adding Participants to Manage
You can add individuals to your Management list, or parts of the Organisational Structure.
Select the Participants Menu to access the options below.
__________________________________________________________________
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Add Participant – Allows one person at a time to be added to the list of participants to be
managed.
1.

Start typing the users name in the Search field and select Search.

2.

Click on the appropriate user’s name.

3.

By ticking the box Set current Supervisor as Manager allows the default Supervisor
from the uploaded Organisation Structure to be set.

4.

If the user has been added correctly, you will receive a confirmation message.

5.

Optionally enter a tag – The Tag field is used to uniquely identify all surveys for a single
participant.

6.

Optionally enter a message – Enter a personalised message to be provided for each
survey response. This message appears between the survey at the top of the survey
preamble and the first question.

The participant will now appear in your list of Participants to Manage, and they will be added to
the count of participants on the front of your survey.
If they have already been invited to participate in the Survey by another user, you will receive a
message informing you, and you will not be able to invite them.
You may Delete Participants by contacting the Module Administrator.
Add Organisation Structure – Allows whole sections of the Organisation Structure to be
added to the participants list to manage. Drill down to children groups of the structure by
clicking on the arrows next to the name of the group. Select one or more appropriate areas to
add. By ticking the box Set the current Supervisor as Survey Manager allows the default
Supervisor from the uploaded Organisation Structure to be set.
Import – Allows a list of participants in CSV file format to be uploaded.
Tip: click on the text Download a sample import file here to see a sample file.
Export – Allows selected participants, or organisation groups, to be downloaded in CSV file
format.

Selecting Groups of Participants
You can select individual users by clicking on the box next to their name.
You can also select groups of participants by clicking on the Select menu.
The select function provides a drop-down list of groups that can be selected:
•

All – All participants

•

None – Deselects All participants

•

No invitation sent – selects all participants that have not been sent an invitation email

•

Submitted – Participants who have completed and submitted their survey
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•

Not Submitted – Participants who have not submitted their survey

•

In Progress – Participants who have started but have not submitted their survey

•

Not Started – Participants who have not started the survey at all.

•

Select lower levels – If this is checked, when a person is selected, any participants they
manage will also be selected.

Note: Selecting participants from the Select button is cumulative: that is, you can Select
multiple groups such as “Incomplete” and “Not Started”.

Other Actions
Once you have selected your participants, there are several actions that can be carried out by
accessing the Action Menu.

Depending on the level of permissions a Survey Manager has been given, you may see some,
or, all the Actions described below.
•

Send Email – Allows an email to be generated to the selected participants. There may
be several email templates available to choose from if the Survey Administrator has
created them.

•

Assign Can Delegate –Gives permission to a user you manage to Delegate their survey
to someone else to complete. Only available if you yourself have Delegate Permission.
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•

Unassign Can Delegate – Withdraws permission for a user you manage to Delegates
their survey to someone else to complete. Only available if you yourself have Delegate
Permission.

•

Assign Can Invite – Gives permission to a user you manage to Invite others to the
survey. Only available if you yourself have Invite Permission.

•

Unassign Can Invite – Withdraws permission to a user you manage to Invite others to
the survey. Only available if you yourself have Invite Permission.

•

Reopen Responses – Allows the Manager to reopen a participant’s survey for editing
by the participant.

•

Delete Responses – Allows the Manager to delete all responses to the participant’s
survey, allowing the participant to start again.

Description of the Columns in the Participants Screen

Note: Show all columns or hide columns by toggling the Compress/Expand View button.
•

User: Name and login of users to Manage.

•

Tag: The Tag field is used to uniquely identify all surveys for a single participant.

•

Message: A personalised message can be provided for each survey response. This
message appears between the survey at the top of the survey preamble and the first
question

•

Organisational Structure: Where in the Org Structure the user comes from.

•

Can Delegate: Tick indicates the user has been given permission to delegate their
survey.

•

Delegated To: The name of the user the participant has delegated their survey to.

Can Invite: Tick indicates the user has been given permission to invite other participants
to the survey.
__________________________________________________________________
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•

Proxy: The name of the user who may complete the survey on the participant’s behalf.
Only Module Administrators can create a Proxy.

•

Open: This date overrides the survey open date just for the selected participant.

•

Close: This date overrides the survey close date just for the selected participant.

•

Notified: Date the user was originally notified about the survey.

•

Last Reminder: Date the user was most recently reminded to complete the survey.

•

Reminded: The number of times the user has been reminded to complete the survey.

•

Started: The date the user began the survey.

•

Submitted: The date the user submitted the survey.

•

View: Once a participant has started their survey, the Manager can view the survey by
clicking on the “View”. Note: editing of other participant’s survey is not permitted.

Analysis of Survey
Navigation: Manage > Survey type > Action > Analysis

The Analysis Screen provides reports on the Manager’s participants. These reports are sub-sets
of the main reports. Please see Section on Analysing the Results of a Survey for tailoring the
reports.
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CREATING AND ADMINISTERING A SURVEY
(Administrator Function only)
You will only be able to administer a survey if you have been given permissions as a:
•

Module Administrator, or

•

Survey Administrator

If you are the creator of a survey you will automatically be given permission as the Survey
Administrator for the survey.
This section will describe the processes required to create, design, manage, report and analyse
any type of survey including a compliance survey.

Creating a New Survey
You can create surveys if you have been given permission to create surveys.
There are two ways to create a new survey:
1.

Copy an existing Survey
Copying an existing survey will copy all data from the selected survey including:
questions, participants, permissions, workflow settings, email templates etc.
Modifications can be made to a copied survey.

2.

Create a Blank Survey
This method will provide a blank template to build from. Only those settings defined by
the System Administrator will be prefilled.
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Copy an Existing Survey
1.

Navigate to: Manage > Survey type (eg Compliance Survey)

2.

Select the Action button next to the survey required to copy. Copy will only copy the
survey configuration. Copy with Participants will copy the survey configuration and all
participants. Copy with Responses will copy the survey configuration and all
participants and their responses.

3.

A confirmation screen will appear. Select OK.

4.

The Survey Administrator may now work through the survey to edit as required.

Create a Blank Survey
1.

Select: New > Survey Type (eg Compliance Survey) OR

A blank survey will be created to begin working in.
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Configuring a Survey
To configure a survey, Open the Survey, Click the Design Tab then click the Configuration
Tab.
The Save, Copy and Delete buttons can be used at any time throughout the survey designing
process.
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The Configuration screen allows you to define key details relating to the survey like name,
period of operation and general display.
Below is a description of the fields in the Configuration screen for the new Compliance survey.
If you have copied it from a previous survey the fields will be pre-filled the same as the original
survey, except for the Identifier number. Edit these fields as appropriate.
Name: This is the name of the survey all users will see in their In-Trays.
Identifier: an autogenerated code that uniquely identifies this survey, allowing a direct URL for
access.
Access Method: defines how the survey is accessed by participants. Options are:
•

Invite Only – participants must be explicitly invited by the administrator by adding them
to the participants section of the survey

•

All Users – All users will be able to respond to the survey and the survey will appear in
all user’s in-trays.

•

On Demand – Users may select to perform the survey from the New menu. If this
option is selected, the following is also available;

Allow Participant Selection – Allows users to create surveys/training on behalf of
another user.
Note: On demand surveys/training are not automatically included as a menu option.
Menu options for on demand surveys/training are configured by the system
administrator via the menu management function.
•
Open date: the date this survey will become available to participants.
Close date: the date this survey will no longer be available for response submission.
Period: the reporting period this survey is attached to. This is required if any question in the
survey will be a Non-Compliance question. The Period restricts Non-Compliances shown in the
response screen to only those reported against this period. See Section for Non-Compliance
Reporting periods.
Participant can select organisation structure- allows participant to select the organisation
unit to be linked to the survey. Selecting “Never” will cause the participant’s organisation unit,
as currently recorded in the system, to be selected automatically.
__________________________________________________________________
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Organisation Structure is mandatory – If Participant can select organisation structure has
been set to “Always” or “Only if Participant has no organisational structure recorded” the
system will prompt “Organisation Structure is mandatory”. Checking this will prevent the
participant from leaving the organisation unit blank.
Display question numbers- turn this off to hide question numbers (useful for conditional
question flow).
Manager Access – determines the access survey managers have to their own survey when one
or more of their direct reports have not submitted their surveys.
•

Allow Access – survey manager has full access to their survey and may submit at any
time.

•

Disallow Submission – survey manager has full access to their survey except may not
submit until all direct reports have submitted.

•

Disallow Access – survey manager has no access and survey will be hidden from all intrays.

Allow delegates to redelegate- Permission can be given for survey delegates to redelegate to
another delegate. This allows a survey to be passed between any number of people prior to
final submission by the participant. See “Allow delegates to redelegate” option in survey
configuration.
Allow multiple responses- Participants can be allowed to submit multiple responses to a
survey. This is useful where one person may be responsible for submitting surveys for more
than one subject or area.
Archived- only non-archived surveys will be available for participants.
Select the ‘save’ button.

Setting up the Survey Preamble
The preamble is the text at the top of the survey that provides the participant with instructions
on what to do and any other relevant information and is displayed when the survey is being
responded to. Documents and videos can be uploaded to the preamble section of a survey.
For online training modules, a video of the tutorial is uploaded in this section.
Preambles are entered using a standard word editing function in the preamble tab. To set the
wording for the survey Preamble, click on the Design Tab then the Preamble Tab.
Design – is the default view and allows you to add and edit the text in a standard MS word
editor .
HTML – to select HTML, select the HTML tab at the bottom of the text editor. This option
allows you to view the text in HTML format. Text in HTML format can be copied into this view.
Preview – to see how your preamble will appear on the survey select the ‘preview’ tab at the
bottom on the text editor.
__________________________________________________________________
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Upload a document:
1.

Select the ‘insert image’ icon

2. Select whether the document is being uploaded from a URL or from your computer
3. If from URL enter the URL, if from computer select the ‘browse’ button to select the file
4. Select the insert button.

Upload a video
1.

Select the ‘insert video icon

2. Select whether the video is being uploaded from a URL or from your computer
3. If from URL enter the URL, if from computer select the ‘browse’ button to select the file
4. Select the more options check box
5. Enter the width and height of the video that you wish to have the video displayed at.
Note: if you don’t know the width and height enter ‘940’ in the width and the system
will assign the correct height. The video size can be determined by viewing the video
properties (right click on the video in file explorer > Properties > Details).
6. Select Preload mode to ‘Auto’ to load the first frame of the video when the survey /
online training is opened by the user.

__________________________________________________________________
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Setting up the Survey Declaration
Survey Administrators can require participants to agree to a declaration before submitting a
survey. This is optional.
To set the wording for the survey Declaration, click on the Design Tab then the Declaration
tab.
The Require Declaration check box will default to no. It can be checked if required. Checking
the require declaration box ensures that respondents must agree to the declaration before
submitting their response.
Design – is the default view and allows you to add and edit the text in a standard MS word
editor .
HTML – to select HTML,select the HTML tab at the bottom of the text editor. This option
allows you to view the text in HTML format. Text in HTML format can be copied into this view.
Preview – to see how your preamble will appear on the survey select the ‘preview’ tab at the
bottom on the text editor.

Setting up Survey Email Notifications
To set up email notifications to be sent to participants for the survey Select the Design Tab,
then the Email Settings Tab.
Email notifications are managed over 2 tabs. Some email notifications can be scheduled
for automatic sending. The schedule is controlled in the email setting tab. Whilst the
actual notification email templates are managed in the ‘Notifications’ tab.
Auto Reminder schedule – This function allows you to configure reminders to be
automatically sent to participants who have not submitted their survey. Note: You must also
ensure the ‘Participant Reminder’ notification in the ‘Notifications’ tab has been selected.
Reminders start – Checking if reminders are required will be performed on and after this date. If
the Reminders start date is left blank reminder notifications for the survey will not be sent.
Cycle (days) – Enter the number of days between each email reminder notification. If the
number of cycle days has passed since the last reminder to a participant, or there has been no
reminder, a reminder notification will be sent.
Subordinate Progress Emails- This is used to send progress emails to the Survey Manager
about the progress of their subordinate’s surveys. Value selected in Cycle (days) must be > 0.
Where no progress emails are required, set the date field to null. Ensure that ‘Manager
Subordinate Progress Notification’ has been selected to ‘Send email’ in the ‘Notifications’ tab.

__________________________________________________________________
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Notifications
The Notifications tab allows you to manage the types and content of email notifications that
are sent to survey participants.
The FMCS comes pre-configured with a standard list of notifications. Notifications can be
turned off if not needed but new ones cannot be created.
Notification descriptions can be found by selecting the edit button next to the notification type.
To select a notification, navigate to Design > Notifications
1.

Review the standard email notifications

2. To remove a notification, select the edit box for the required notification and uncheck
the ‘send email box’
3. To modify the notification, select the ‘edit’ button and make changes. Select the ‘tick’
button to save.
Modify a Notification:
When modifying a notification, any of the fields can be modified using text and / or one or
many merge fields. A merge field is a predefined tag that when selected populates the
relevant information into the notification email. For example, if you select ‘Participant First
Name’ into the ‘To Line’ field the system will derive the participant’s First Name to be used
in the email notification.
To populate merge fields into the required field, select the Edit function at the end of the
field. Merge fields are grouped into categories to make selecting them easier. The
following list explains the merge fields:
Recipient Fields: Contain all the relevant fields that relate to the recipient of the email
like Recipient First Name, Last Name, AGS Number, Organisation unit etc
Participant Fields: Contain all the relevant fields available that can be included for the
participant eg, First Name, Last Name, AGS Number, login, email address, Org unit etc
Survey Fields: Contain all the relevant fields available that can be included for the
Survey eg: Survey title, URL, tag, message etc.
Delegate fields: Contain all the relevant fields available that can be included for the
delegate eg, First Name, Last Name, AGS Number, login, email address, Org unit etc
Manager Fields: Contain all the relevant fields available that can be included for the
Survey Manager eg, First Name, Last Name, AGS Number, login, email address, Org unit
etc
System Fields: Contain all the relevant system fields available that can be included
Survey eg, System title, Org structure title, Supervisor title etc.
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Granting Survey Permissions to Others
The Survey Administrator can grant permission for participants to have Administrator or Read
only (reporter) access.
Update Access – allows users to have permission to administer this survey.
View Access- are users who can access a read-only view of all survey management functions,
including participants and analysis for this survey.
Select the Design Tab, then the Permissions Tab.

Use the Grid Management buttons to Add, Edit and Delete users. Once a participant has been
selected to edit, simply check or uncheck the relevant box as Update access and/or View
access.
Groups can also be given permissions for a Survey. Instead of adding an individual, click into
the Group column and find the relevant group from the drop down menu.
To create new groups or edit existing groups see the Systems Administration and Global
Settings Guide.
Restricted Survey – Restricts users who can access the survey’s administration to only those
users explicitly identified in the list of users with permission. If selected, even module and
system administrators will not have access unless explicitly selected.

Setting Survey Questions
Now that the survey has been designed, it needs to have questions added for participants to
answer. This section allows you to configure your survey questions. You will be able to add
new questions, modify existing questions and define the behaviour of these questions in this
section.
Surveys can have any number of questions. New questions can be added, or Questions from
your Question Bank can be selected.
Note: This manual provides information and instructions on all Question and Answer Types
relevant to the General Survey Module. If your organisation is only operating the Non__________________________________________________________________
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Compliance Survey Module, you will only be able to see the Non-Compliance Question and
Answer Types in your FMCS.

Add a General Question
Click on the Add Question button.
Title: Enter an optional title for the question.
Note: Questions will be saved in the Question Bank grouped together by title.
Question Text: Type the question, using standard Microsoft Word editing features such as font,
bullets, numbered lists, tables etc.
Response Type: Select the response type that best fits the question. To assist in obtaining
consistent and quality answers, FMCS has a number of different response Types to select from.
Note: This manual provides information and instructions on all Question and Answer Types
relevant to the Survey Module. If your organisation is only licenced to use the Compliance
Survey Module, you will only be able to see the Non-Compliance Question and Answer Types
in your FMCS.
Standard answer types in FMCS are:
1.

Non-Compliance (compliance surveys only)
Non-Compliance questions are specific to Compliance surveys only. When other survey
types are being created the ‘Non-Compliance’ option is not displayed for selecting.
Where ‘Non-Compliance’ is the selected response type the system will display all
recorded non-compliances for the question to the survey participant where:
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•

the participant is involved in the non-compliance in any of the following
capacities:
o

Committer of the non-compliance

o

Supervisor nominated in the non-compliance

o

Have edited or updated a non-compliance

•

the participant is the current supervisor of the organisation unit nominated in
the non-compliance

•

the participant is the current supervisor of an organisation unit at a higher level
to the organisation unit nominated in the non-compliance

•

Permission has been given to survey participants to view non-compliances
where the organisation unit in the non-compliance is the same as the
participant’s current organisation unit

•

Permission has been given to survey participants to view non-compliances
where the organisation unit in the non-compliance is below the participant’s
current organisation unit

•

the participant has been given specific reporting permission to the organisation
unit in the non-compliance, or;

•

the non-compliance is viewable by anyone who the participant is the Survey
Manager for.

2.

Short Text
Allows a free text response with a small text box. Maximum characters can be set.

3.

Long Text
Allows a free text response with a larger text box. Maximum characters can be set.

4.

Yes/No
Allows only a Yes or No response.

5.

Single Select List
The Survey Administrator defines the list, but only allows one answer to be selected.

6.

Multi Select List
The Survey Administrator defines the list. Any number of items may be selected.

7.

Date Picker
The date picker is displayed in the standard calendar selection format. Minimum and
maximum date ranges can be defined if required.

8.

Numeric
Minimum and maximum ranges can be defined if required.

9.

None: No response is required for the question. This effectively allows the survey to be
configured with section separators and other text only formatting.
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Answer Type Options
Depending on the answer type selected above, the system may ask you to provide further
values to define the answer type. Any of the following options may be available for the Answer
Type selected.
Non-Compliance Answer type only (Compliance Surveys only)

1.

Response indicating a Non-Compliance: This allows the person creating the
survey to identify which answer (either Yes or No) indicates a non-compliance may
have occurred. Questions can be asked in way that a Y may indicate a noncompliance and in others a N may indicate a non-compliance.

2.

Non-Compliance Category – select the Category from a predetermined list set up
by the Module Administrator.

3.

Non-Compliance Question – select a Non-Compliance Question from a
predetermined list set up by the Module Administrator from within the Category
relating to a specific requirement from the financial framework. Non-Compliance
Question is optional and is only required when the survey question relates to a
particular requirement.

4.

Include N/A Response – Provides an N/A response option. Note: an N/A response
is treated the same as answering a non-compliance has not occurred.

5.

Force positive response when non-compliance exist – When checked, the answer
to questions where non-compliances are recorded will be forced to be answered
with a the positive response.
Note: where a question already has non-compliances recorded for a participant, the
question’s answer will automatically be set to the positive response.

Include N/A response
Select this option to allow an N/A response when Yes/No Answer Type is selected.
Answer length
Limits the size of answer allowed.
N/A Response
Allows a Not Applicable response for Non-Compliance and Yes/No response types.
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Values
If a Single Select or Multi-Select answer type is chosen, enter one value per line. Tick the
Allow ‘Other’ box if an additional text box is to be displayed if “Other” is chosen to allow
further information to be added by the participant.
Include Document Upload
Set the question to allow document upload to be optional or mandatory depending on the
answer provided.
Capture Additional Information
Set the question to request further information to be provided to be optional or mandatory
depending on the answer provided.
Record Exceptions
Set the survey to flag an answer as an “Exception”. Exception responses have special
reporting features.
Correct answer required
Set this answer to a predetermined response before the participant can proceed. Often
used for creating training review type questions.
Required Answers
An answer can be made Mandatory by selecting the Require an answer.
Prerequisite
The question is only displayed if the appropriate answer is provided in the selected
prerequisite question. (Not available for Question 1.)
Help
can be included for each question including hyperlinks to internal or external
sources.
Note: You will not be able to change the answer type if one or more participants have
responded to the question.
Note: The options for Answer Type depend on the modules your agency has implemented.
You may not have access to all Answer Types shown above.

Questions from the Question Bank
Using Questions from the Question Bank
Questions that have been saved to the Question bank can be quickly added to other surveys by
selecting them from their category heading.
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Adding and deleting Questions in the Question Bank
To add questions to the question bank select the Action tab to the side of the question and
selection the Add to Bank option.

To delete questions from the question bank, click on the “delete” text next to the question.
Note: The Question Bank belongs to your agency. Any editing you do to the Question Bank will
affect all Survey Administrators in your agency.

Managing Questions
By selecting the Action tab to the right of a question, there are several actions you can take to
change questions that have been saved into a survey.
Edit: Allows the question to be edited.
Insert a section break – A section can be configured by creating a question and selecting
“None” in Response Type. This effectively allows the survey to be configured with section
separators and other text only formatting.
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Add to Bank: Allows this question to be added to the Question Bank. Adding a Category to the
question will allow the questions to be grouped when displayed in the Question Bank.
Copy: Allows the question to be copied to the end of the survey.
Delete: Allows the question to be deleted from the survey.
Move Up: Allows this question to be moved up the order of questions in the survey.
Move Down: Allows this question to be moved down the order of questions in the survey.
Move To: Allows this question to be moved to a specified number position in the survey.

Exporting Questions
Questions can be exported to a csv file by selecting the Export Questions button on the
Questions tab.
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Adding Participants to the Survey
If the survey has been created by copying a previous survey, all the participants will have been
copied as well, including the permissions previously given.

If the survey has been created from New the participants screen will be empty.
Survey participants can be invited individually or in bulk.

Adding Individual Participants
1.

Select Add Participant from the Participants Menu.

2.

Start typing the participant’s name into the name field and select Search.

3.

Click the participant’s name from the list.

4.

Tick the Set current Supervisor as Survey Manager box if you wish to set the Survey
Manager as this participant’s Supervisor. If this option is ticked the system will identify
the first level supervisor from the Organisation structure of the participant and make the
first level supervisor the survey manager for the participant. The first level supervisor will
be added as a participant if required.

If the user has been added correctly, you will receive a confirmation message.

Adding Participants by Organisation Structure
Use this function when you want to add all members from a particular part of your
organisational structure as participants.
Multiple areas within the organisational structure may be selected.
1.

Select Add Organisation Structure from the Participants Menu.
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2.

Tick and drill down to the required level of Organisational Structure to be selected.
Multiple areas can be selected.

3.

Tick the Set current Supervisor as Survey Manager box if you wish to set the Survey
Manager as this participant’s Supervisor.
If this box is not selected, the participant will not have a Survey Manager.

4.

Select the Add button.

5.

If the participants have been correctly added as participants, a confirmation box will
appear.

Adding Participants through Import
Where many participants are required to be added to the survey, whether this is to add initial
participants to a new survey or additional participants to an existing survey the FMCS provides
an import facility to make the process of adding participants more efficient. This is a 2 step
process. First you will need to create or modify the import template and then upload the file.
Create the Import Template
If you already have a prepared import file then skip this step and go directly to the next step
‘Import the participant file’.
1.

Select Manage > Survey type > Action > Design > Participants >Participants >
Import
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2. Select the ‘Download your current participants in the correct format here’ link. The
FMCS will download an excel template in MS Excel. The template will be populated with
all current survey participants. If there are currently no survey participants, the template
will be empty.
3. If the survey does not yet contain any participants, populate the participant details
starting on Line 2 in the excel template.
4. If you are importing additional participant, locate the next available row in the template
and populate the additional participant details. Note: The current participants on the
excel template do not need to be deleted as the FMCS recognises all existing entries
and will only update changes to an existing record or insert a new record for each new
participant added.
5. To modify entries in the template file, locate the desired record and manually make the
update to the row. The FMCS contains a Unique ID for each participant record,
therefore by updating data within a record (make sure you don’t manually update the
ID field) the system will accept the update and not duplicate the record.
6. Update the template with the participants – if you are adding participants to an existing
list, the FMCS will populate all current participants into the template with each record
being assigned a unique ID. This ID allows you to update any details for any participant
and the FMCS will update the record instead of creating a new record.
7. Save the file. Note: the file will by default save to the downloads directory.
Now you are ready to import the participant list.
Import the participant list
1.

Click the Browse button and select your CSV file. If you have a file prepared earlier
then locate the desired file from the file directory. If you created the file as part of the
last step the file will stored in the downloads directory and will be the last file created.
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Note: Only participants who are already recorded as users in the system may be
uploaded.
2. Select the Upload button.
3. A partial sample of the import will be displayed. If this is correct. Select the Import
button.
4. A confirmation will be appear noting the import has been successful. Note: any import
rows with an error will be ignored.

Exporting Participants
You can export a list of some or all of the participants you manage by using the Export option
from the Participants Menu. This can be used to print a list of participants.
1.

Select the participants to export by either selecting them individually or by group from
the Select Menu.

2.

Select the Export option from the Participants Menu.

3.

A CSV file is generated.

4.

Open and save or print the CSV as required.

Managing Survey Participants
Participants are managed through the Participants screen. They can be invited to the survey,
given various levels of management permissions, responses monitored and bulk emails can be
sent.
Note the different views available to management participants. By toggling the
Expand/Compress View buttons you can view the full or compressed screen.
Compressed View
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Expanded View

To find a participant in the list select the Control Key and F. A search box will appear at the top
right of screen. Add the participant’s name. All matches will be highlighted in yellow on the
screen.
Note: Page numbers will appear at the bottom of the participants when there are 100
participants or more.

Selecting Participants
Before you can perform any Action on a participant, they must first be selected. Individual
participants can be selected or they can be selected in groups.
A participant is Selected if there is a tick in the box next to their name and their line is
highlighted.
You can select individual users by clicking on the box next to their name.
You can also select groups of participants by clicking on the Select menu.
This function provides a drop down list of groups that can be selected:
•

All – All participants

•

None – Deselects All participants

•

No Invitation Sent – Selects participants who have not been sent an invitation email

•

Submitted – Only participants that have completed and submitted their survey

•

Not Submitted – Participants who have not submitted their survey. This will select
participants who have not started and also participants who are still in progress.

•

In Progress – Participants who have started by not submitted the survey

•

Not Started – Participants who have not started the survey at all.

•

Select lower levels – If this is checked, when a person is selected, any participants they
manage will also be selected.

Note: Selecting participants from the Select button is cumulative: that is, you can Select
multiple groups such as “Incomplete” and “Not Started”.
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Finding Participants
Enter the name or part name of the person in the search box and press return.

Action Menu
Once you have selected your participants, there are several actions that can be carried out.
•

Send Email – Allows a general email to be generated to the selected participant/s. An
entry of the email will appear in the log.
The send email function utilises the ‘merge fields’ function.

The Subject line of the email may include one or more merge fields. A merge field is a
predefined tag that when selected it will populate the relevant information into the
email. For example, if you select ‘Survey Title’ into the ‘Subject’ line field the system will
derive the correct Survey Name to be used in the email notification.
To populate merge fields into the Subject line:
1.

Locate the required merge field by hovering over the merge categories (see list
on page xx
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2. The merge field will populate into the Body of the email
3. Cut and paste the merge field from the body to the subject. The merge field can
also be typed directly into the Subject field if you know the merge fields tag.
4. Add any merge fields and or text into the body of the email (make sure the
merge field/s selected for the subject line have been removed).
5. Select ‘Send’.

•

Send Invitation – By selecting a user/s, you can invite a participant to take part in a
survey. Used when adding additional participants to a survey. Note: Will not be sent to
managers who have subordinates with incomplete surveys if Restrict Manager Access is
turned on.

•

Send Reminder – By selecting a user/s, you can manually send a reminder to a user/s
that a survey is required to be completed. Note: Will not be sent to managers who have
subordinates with incomplete surveys if Restrict Manager Access is turned on.

•

Assign Can Delegate –Gives permission to a participant to Delegate their survey to
someone else to fill out. A tick in the Delegate column indicates this permission has
been given.
Note: A delegate must Submit the survey back to the original participant for final
Submission. However, a Proxy can Submit a survey on behalf of the Participant.
•

Re-delegate – Permission can be given for survey delegates to redelegate to another
delegate. This allows a survey to be passed between any number of people prior to final
submission by the participant. See “Allow delegates to redelegate” option in survey
configuration.

•

Unassign Can Delegate – Withdraws permission for a participant to Delegate their
survey to someone else to complete.

•

Assign Can Invite – Gives permission to a participant to Invite others to the survey. A
tick in the Can Invite column indicates this permission has been given.

•

Unassign Can Invite – Withdraws permission to a participant to Invite others to the
survey.

•

Set Open & Close – Allows the Survey Manager to limit the Open & Close dates for the
selected participant within the Open & Close dates of the Survey set in the Design
screen.
•

Change Owner – Changes the participant nominated in a survey to a different
participant. Allows responsibility for a survey response to be transferred to a different
person.
o
o
o
o

Select the participant you want to move the survey response from;
Select the ‘Action’ function;
Select ‘Change Owner’
Enter the new Owner
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The survey response will now show as assigned to the new user.

•

Set Tag and Message – Select this option to set a Tag (a field to uniquely identify all
surveys for a single participant) and Message (a personalised message to be provided
for each survey response).

•

Assign Proxy – allows the Survey Administrator to nominate a Proxy for this participant.
The proxy can submit a survey on another’s behalf.

•

Remove Proxy – Withdraws permission for a proxy to complete the survey.

•

Add Supervisor as Participant – Add a new participant and add their supervisor as
listed in the organisational structure, as their manager to the survey.

•

Assign Manager – Assign a manager to an existing participant.

•

Set Supervisor as Manager - Sets the supervisor of an existing participant as listed in
the organisational structure as the participant’s manager in the survey.

•

Remove Manager – Removes the manager for the selected participant.

•

Reopen Responses – Reopens the participant’s survey for editing and resubmission.

•

Clear Responses – Deletes all responses in the participant’s survey, allowing the
participant to start again. Responses may only be cleared if the participant’s survey is
currently open.

•

Delete Participant – removes a participant from the survey.

Exceptions
An exception is a response that differs from the usual responses in a survey. Survey
administrators can configure questions to trigger exceptions when a particular response is
selected against a survey question. The ‘Exceptions’ tab shows all exceptions logged within a
response. A survey manager can view all exceptions.
Click on the Exceptions tab to see all those participants who answered any question with an
answer that indicates an exception.
Note: The Survey Administrator sets up the Exception indicators.

Columns
Note: Show all columns or hide columns by toggling the Compress/Expand View button.
User: Name and login of users to Manage.

•
•

Tag: The Tag field is used to uniquely identify all surveys for a single participant.

•

Message: Enter a personalised message to be provided for each survey response. This
message appears between the survey at the top of the survey preamble and the first
question.

•
Classification: APS grade of the user
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•

Organisational Structure: Where in the Org Structure the user comes from.

•

Can Delegate: Tick indicates the user has been given permission to delegate their
survey.

•

Delegated To: The name of the user the participant has delegated their survey to.

•

Can Invite: Tick indicates the user has been given permission to invite other participants
to the survey.

•

Proxy: The name of the user the survey has been sent to for completion on their behalf.
Only Module Administrators can create a Proxy.

•

Open: This date overrides the survey open date just for the selected participant.

•

Close: This date overrides the survey close date just for the selected participant.

•

Notified: Date the user was originally notified about the survey.

•

Last Reminder: Date the user was most recently reminded to complete the survey.

•

Reminded: The number of times the user has been reminded to complete the survey.

•

Started: The date the user began the survey.

•

Submitted: The date the user submitted the survey.

•

View: Once a participant has started their survey, the Manager can view the survey by
clicking on the “View”. Note: editing of other participant’s survey is not permitted.

Closing a Survey
A survey will automatically close based on the close date entered in the configuration for the
individual survey. Once the Close date has been passed participants will no longer be able to
access the Survey.
The Close date can be changed by the Survey Administrator should this be required.
To change the Closing date go to Manage Survey (type) > Select the survey > Design Tab for
the survey and over-write the closing date. Select the Save button.
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Analysing the Results of a Survey
Results from the survey are visible only to the Survey Administrator. Participants can be
granted access to view survey results through the permissions tab.
To analyse and export data for this survey, click the Analysis tab in the top right of screen.

A summary showing the status of invitations and responses is presented at the top, including
any comments entered for this survey as a whole.

Action Menu
Export to Excel: To export survey response to excel includes responses to all answers.
Edit Survey Comments: To edit the comments for the survey as a whole.
Download Attachments: Downloads all the attachments participants uploaded as part of their
response to the survey.
Print: Prints the Analysis screen with all charts.
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Question Analysis
Question data is displayed below the survey summary, showing tabulated responses and,
where applicable, a graph of the data.

Comments for each question can be managed by selecting Edit Comments from the question's
Action menu. Comments are displayed in-line with the question.
Response Bands
You are able to create aggregate banding for responses by selecting Edit Response Bands
from the question's Action menu. To add a new band Select Add New, or select an existing
band from the drop-down menu to edit. Provide a label and select the responses to be
included in this band. Note that numeric and date response types allow start and end values for
the band rather than individual responses.
1.

Enter the description for this band

2. Selecting Include all unbanded responses will catch all otherwise unbanded responses
and aggregate them into this band.
3. Indicate Y/N for responses
4. Selecting Hide this band will stop the responses in this band from appearing in the
analysis screen and from being exported to Excel.
5. Save
To edit an existing band select a value from the drop down menu.
Download Attachments will download all attachments participants uploaded for this Question
only. The download attachments option will only display if attachments are saved against a
question.
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Filtering Survey Results
The View Manager function allows the results of the survey to be filtered by a number of
different criteria.
Select the View Manager tab to define the filters.

Filters can be applied across the following criteria:
Date: a date range of when a response was submitted.
Organisational Structure: Use the drop down box to select one or multiple areas of the
organisational structure.
Users: Select individual or multiple users from the search field.
Exceptions: Select the tick box to view only those responses containing exceptions.
Response Bands: Apply Response Bands (raw data vs banded aggregates).
Questions: Filter on one or more questions.
Save View As: Once the filters have been applied, the View can be given a name and saved for
retrieval at a later time. Select the Share saved view box to allow other Administrators to view
this saved filter.
Load View: Retrieve a previously saved filter.
Applies all the filter criteria selected.
Removes all the filter criteria selected.
Closes the View Manager.
Note: Filter views do not apply to the Response Summary Chart, only to the individual
questions.
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